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ColorWorks C3500
INSTALLATION DE
L' IMPRIMANTE

Limprimante ColorWorks C3500 est fournie avec un CD sur lequel figure les supports suivants :

CONTENU DU CD DESCRIPTION

Install Navi Assistant d'installation pour la
configuration du pilote et de limprimante

Nicel.abel SE for EPSON Application pour commencer a concevoir
et a imprimer des étiquettes avec
la ColorWorks C3500

EpsonNet Config Configuration et gestion de plusieurs

imprimantes en réseau

Technical Reference Guide Informations relatives a I'installation de
Iimprimante, au développement et a la
conception des applications d'impression

Pour installer I'imprimante ColorWorks C3500, lancez simplement le logiciel Install Navi et suivez
les instructions illustrées. Elles vous guideront tout au long du processus complet d'installation
de limprimante (du branchement de l'alimentation a 'installation du pilote d'impression).

Voici I'écran d'installation du logiciel EPSON Nawvi.

En fonction de la largeur du support, il convient d'ajuster les réglettes du capot pour papier
rouleau. Siles parametres des réglettes sont incorrects, cela peut entrainer un bourrage papier
ou des traces d'encre sur le support.

Veulillez vous reporter a I'étiquette sur le dessus de l'imprimante.

Il est important de veiller a utiliser le parametre de détection du support approprié. Selon
le type de support, le parametre de détection peut étre défini sur « Black Mark » (Marques
noires), « Gap » (Espace) ou « No detection » (Sans détection). De mauvais parametres sont
susceptibles de générer une erreur de type « Media Form Error » (Erreur de format de support).
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ColorWorks C3500

MPRESSION DE
PREMIERE ETIQUETTE

A

(AVEC LE LOGICIEL NicelL.abel FOURNI)

Remarque : Toutes les imprimantes d’étiquettes couleur ColorWorks C3500 sont fournies
avec le logiciel « NicelLabel Starter Edition (SE) for Epson ». NicelLabel dispose de I'interface
EPDI (EPSON Printer Driver Interface) intégrée. Cette API permet de modifier les paramétres
du pilote a partir de I'application utilisateur.

Lancez I'application Nicel.abel

1.
2.
3.

Définissez la taille d’étiquette lors de la création d’une nouvelle étiquette
Ajoutez les textes, codes-barres, images ou graphiques que vous souhaitez

Utilisez le bouton « Color » (Couleur) pour apporter de la couleur au contenu des étiquettes
(par exemple, texte/images)

Sélectionnez « File » (Fichier) — « Printer Settings » (Parametres de I'imprimante) pour
modifier le parameétre du support (par exemple, mat, brillant, synthétique) ainsi que les
parametres de qualité. Validez ensuite vos choix en appuyant sur « OK »

Sélectionnez « File » (Fichier) — « Print ... » (Imprimer...) et appuyez sur « Print » pour
imprimer votre premiere étiquette
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ColorWorks C3500
I\/IDRESS ON DE LA
PREMIERE ETIQUETTE

(AVEC UN AUTRE LOGICIEL)

Remarque : Les applications ne disposant pas de I'interface EPDI (EPSON Printer Driver
Interface) doivent utiliser les mises en page pré-définies du pilote.
1. Enregistrer un nouveau format d'étiquette

a) Ouvrez le pilote de la ColorWorks C3500
(« Devices & Printers » (Périphériques et imprimantes) -> (clic-droit) Epson Color\Works
C3500 -> (cliquez sur) « Printing Preferences » (Options d’impression)

b) Cliquez sur « User Defined » (Défini par I'utilisateur)
c) Saisissez le nom de la mise en page (par exemple, « Etiquette Chaussure »)

d) Sélectionnez le format du support

DESCRIPTION DE LA
POSITION DU SUPPORT

Die-Cut Label (Gap) Détection de I'espace entre les
Etiguette pré-découpée (avec espace)  étiquettes

PARAMETRE DE DETECTION

Die-Cut Label (BM) Détection de margues noires entre
Etiguette pré-découpée (@ marque noir)  les étiquettes
Full-page Label Sans détection

Etiguette continue

Continuous Paper Sans détection
Papier continu

Black Mark Continuous Paper Détection des marques noires
Papier continu & margue noir

e) Saisissez la largeur et la hauteur de I'étiquette
f) Cliquez sur « Add » (Ajouter)

2. Ouvrez le modele d’étiquette (fichier) dans un logiciel Windows standard
- (exemple : en cas de fichier image, veuillez utiliser Microsoft Photo Viewer)

3. Cliquez sur « Print » (Imprimer) (ou Ctrl + P)

- Dans la fenétre du menu d’impression, sélectionnez :
a. Pour "Printer" : sélectionnez "Epson ColorWorks C3500"
b. Pour "Paper size" : sélectionnez "Shoe label"

c. Optez pour « Quality » (Qualité) ou « Speed » (Vitesse) en termes de qualité d’impression

d. Pour "Paper type", sélectionnez le type de support utilisé (exemple : "glossy label"
pour du média brillant)

- Saisissez le nombre d’étiquettes que vous souhaitez imprimer et cliquez sur « Print »
(Imprimer)
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ColorWorks C3500
PILOT

Via plusieurs onglets, le pilote d'impression EPSON ColorWorks C3500 donne acces aux
différentes options et fonctionnalités de I'imprimante. En voici une présentation :

1. Onglet « General » (Général)

- « Print Settings » (Parametres d'impression) => « Media Type » (Type de support) : Plain
(standard), Matte, Glossy (brillant)

Le tableau ci-dessous présente une description plus détaillee
des parametres Media Type (Type de support) disponibles
dans le menu déroulant.

TYPE DE SUPPORT DESCRIPTION
Plain (Simple) Papier non couché
Plain Label (Etiquette simple) Ftiquette non couchée

2

Synthetic Label (Etiquette synthétique)  Etiquette synthétique couchée

Matte (Mat) Papier mat couché

Matte Label (Etiquette Mat) Etiquette Mate Couchée
Wristband (Poignet) Bracelet synthétique
Glossy Label (Etiquette Brillante) Etiquette Brillante Couchée

Parametres relatifs a la qualité d'impression speed / quality

- « Media Layout » (Mise en page)
(définition de la taille du support) ; « Roll Paper Saving »
(suppression des marges sur les étiquettes)

- Parametres du massicot => « Auto Cut »/« No Auto Cut » (Découpe automatique/Sans
découpe automatique)
- Parametres des signaux sonores => beep (bip apres chaque impression)/No bip (sans)
2. Options .
- Modifier I'orientation de l'impression (portrait/paysage)

3. « Driver Utilities » (Utilitaires du pilote) :
- Préférences du pilote (unités de mesure, moniteur d'état, etc.)
- Moteurs d'impression de codes-barres internes
- Importer/Exporter les parametres du pilote

4. Maintenance et utilitaires

- Vérification des buses (Nozzle Check) => imprimez un modele de vérification des buses
pour vérifier si une des buses est obstruge

- Nettoyage manuel de la téte (Manual Head Cleaning) => effectuez un nettoyage de la téte
en cas d'obstruction des buses

- Parametres de limprimante (Printer Settings) => se référer au chapitre suivant
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ColorWorks C3500

U

LI

AIRE DES PARAM

DE LIMPRIMANTE

[Tl

RES

Le "Printers Settings Utility" ou PARAMETRES DE L’IMPRIMANTE, vous permet de configurer
plusieurs parametres de I'imprimante, tels que :

CATEGORIE

Informations
générales

Advanced
Settings
(Parametres
avances)

Printer

Adjustment
(Réglage de
[imprimante)

Settings Save
and restore
(Enregistrement
et restauration
des parametres)

Option

SECTION

Media Settings
(Parametres du support)

Printer Operation
Settings (Parametres
de fonctionnement de
limprimante)

Notify Settings
(Parametres de notification)

Panel button settings
(Parametres du panneau
de control)

Operating time settings
(Parametres de
fonctionnement)

Paper feed adjustment
(Ajustement de
I'alimentation papier)

Sensor adjustment
(Ajustement du capteur)

Print head alignment
(Alignement de la téte
d'impression)

/

PARAMETRE

Media Source Settings (Parametres
de source de support)

Media Position Detection Settings
(Parametres de détection de la
position du support)

Nozzle Check Mode Settings
(Parameétres du mode de vérification
des buses)

Paper loading settings (Parametres
de chargement du papier)

Notify Settings
(Notifier les parametres)

Panel Button settings (Paramétres
du panneau de control)

Platen vacuum settings (Parametres
des plagues sous vide)

Data stand-by settings (Parametres
des données en vellle)

Cut position adjustment (Ajustement
de la position de coupe)

Print start position adjustment -
vertical (Ajustement de la position au
démarrage de limpression - verticale)

Print start position adjustment
(Ajustement de la position de
démarrage de Impression)

- horizontal (horizontale)

Adjust label gap sensor (Ajuster
la détection des espaces entre
les étiquettes)

Adjust black mark sensor (Ajuster
la détection des marques noires)

Banding adjustment (Ajustement

de leffet de bande)

Bi-directional printing adjustment
(Ajustement de l'impression bi-
directionnelle)

Settings Save and Restore
(Enregistrement et restauration
des parametres)

Media Source Settings (Parametres
de source de support)

DESCRIPTION

Définir lmprimante pour utiliser le type de support
Rouleau ou Accordéon

Définir le capteur de détection du support de
limprimante (No detection/Black mark/Gap

(Sans détection/Espace/Marques noires))

Pour en savair plus, consulter le Manuel de référence
technique

Définir le comportement de lmprimante lorsqu'elle
est sous tension ou une fois le capot fermé (par
ex. : alimenter le papier en position découpe ou
impression)

Définir la notification de lmprimante (bip ou LED)
a lafin de limpression, en cas d'erreur ou en cas de
niveau d'encre faible

Activer/Désactiver les boutons (découpe,
alimentation ou nettoyage) sur le panneau
de limprimante

Pour en savoir plus, consulter le Manuel
de référence technique

Pour en savoir plus, consulter le Manuel
de référence technique

Ajuster la position exacte de découpe apres
impression (par tranches de 1/180 pouce)

Ajuster la posttion exacte au

démarrage de limpression - depuis

le bord supérieur du support (par tranches
de 1/180 pouce)

Aluster la position exacte de démarrage
de limpression - depuis le bord gauche
du support (par tranches de 1/180 pouce)

Pour en savoir plus, consulter le Manuel
de référence technique

Pour en savoir plus, consulter le Manuel

de référence technique

Ajustement de la téte d'impression (horizontal) pour
éviter I'effet de bande (lignes blanches ou foncées)
sur les impressions

Ajustement de la téte d'impression (vertical) pour
éviter l'effet de bande (lignes blanches ou foncées)
sur les impressions

Créer ou charger le fichier de sauvegarde avec les
parametres actuels de limprimante

Activer ['utiisation de rouleaux extermes (dérouleur
exteme requis)

10



MEDIA COLORWORKS C3500 -
DEPANNAGE

1 .. utiiser un nowveau support d'une autre taile, mais de méme type (découpé, continu, etc.)

2 ... Utiliser un nouveau type de support (de/a : découpé, continu, avec marques noires)

3

... passer du rouleau au support en accordéon (ou autre)

Parametres du pilote
Windows

EPSON

Définissez une nouvelle mise en page

General (Général) -> Media Layout (Mise en page) ->

User defined (Personnalisée) (pas nécessaire pour
les applications utilisant I'interface EPDI, telle que
Nicelabel)

2

Définissez une nouvelle mise en page

General (Général) -> Media Layout (Mise en page) ->

User defined (Personnalisée) (pas nécessaire pour
les applications utilisant I'interface EPDI, telle que
NicelLabel)

3

Définissez une nouvelle mise en page

General (Général) -> Media Layout (Mise en page) ->

User defined (Personnalisée) (pas nécessaire pour
les applications utilisant I'interface EPDI, telle que
Nicel abel)

11

Parametres du logiciel
d'impression

Modifiez la méthode de détection du support de
l'imprimante via le pilote ou I'utilitaire Parametres :
Pilote : General (Général) -> Media (Support)

-> Media Position Detection (BM/Gap...)
(Détection de la position du support (marques
noires/Espace...)

Utilitaire : General (Général) -> Media Settings
(Parametres du support) -> Media position
detection settings (Parameétres de détection

de la position du support)

Modifiez les parametres du support depuis I'utilitaire
Parametres :

Détection de la position du support : General
(Général) -> Media Settings (Paramétres du support)
-> Media position detection (Détection de la position
du support) Media Source setting (Parametre de
source de support) : General (Général) - > Media
Settings (Paramétres du support) -> Media Source
(Source de support)

Parametres du matériel
d'impression

Si le nouveau support a une largeur différente :
Ajustez les réglettes, voir page 2

Si le nouveau support a une largeur différente :
Ajustez les réglettes, voir page 2

Si le nouveau support a une largeur différente :
Ajustez les réglettes, voir page 2

En cas d'utilisation d'un papier accordéon,
utilisez le guide papier plastifié situé a l'arriere




IMPRESSION COLORWORKS C3500 -
DEPANNAGE

Je souhaite ...
1 ... Imprimer sans marge
2 ... gjuster la position exacte de limpression sur le papier (a 'horizontale ou a la verticale)
3 ... ajuster la position exacte de la coupe sur le papier

Parametres du matériel
d'impression

Parametres du logiciel
d'impression

Parametres du pilote
Windows

EPSON

Modifiez la méthode de détection du support de

Définissez une nouvelle mise en page

General (Général) -> Media Layout (Mise en page)
-> User defined (Personnalisée) (pas nécessaire si
vous utilisez le logiciel NicelLabel) ...dans la méme
fenétre, avant d’enregistrer la nouvelle mise en page,
sélectionnez « Borderless printing » (Impression
bord-a-bord)

2

limprimante via le pilote ou I'utilitaire des paramétres :
Pilote : General (Général) -> Media (Support) ->
Media Position Detection (BM/Gap...) (Détection

de la position du support (marque noire/Espace. ..)
Utility (Utilitaire) : General (Général) -> Media Settings
(Paramétres du support) -> Media position detection
settings (Parametres de détection de la position

du support)

Utilisez I'utilitaire des parametres de l'imprimante pour

linstallation :

Printer adjustment (Ajustement de l'imprimante)
-> Paper Feed adjustment (Ajustement

de l'alimentation papier) :

Ajustement de la position de démarrage

de limpression (direction verticale)

Ajustement de la position de démarrage

de l'impression (direction horizontale)

Utllisez I'utilitaire des parametres de l'imprimante
pour l'installation :

Printer adjustment (Ajustement de l'imprimante) ->
Paper Feed adjustment (Ajustement de I'alimentation
papier) : Ajustement de la position de coupe

Si le nouveau support a une largeur différente :
Alustez les réglettes, voir page 2

Si'le nouveau support a une largeur différente :
Austez les réglettes, voir page 2

12
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CE QUE VOUS DEVEZ SAVOIR
L ORSQUE VOUS IMPRIMEZ
DES ETIQUETTES AVEC LA
ColorWorks C3500

Installez correctement 'imprimante

Ne vous attendez pas adémarrerl'impression
d'étiguettes immédiatement apres l'ouverture
du carton de limprimante

Dans un premier temps, exécutez InstallNavi pour configurer limprimante
(InstallNavi est disponible sur le CD fourni dans le carton ColorWorks C3500).
Familiarisez-vous avec le pilote et I'utilitaire des parametres de 'imprimante ainsi
gu'avec I'imprimante en elle-méme. N'oubliez pas d'ajuster les reglettes sur la
ColorWorks C3500 chaqgue fois gue vous utilisez un nouveau support ayant une
largeur différente.

Utilisez des étiguettes couchées
jet d’encre

N'utilisez pas des étiguettes
congues pour d'autres imprimantes/
technologies

Les étiquettes a transfert thermique et a transfert thermique direct ont un autre type
de revétement supérieur que les étiquettes jet d’'encre, empéchant ainsi I'encre
de sécher instantanément. Généralement, cela génere des taches d'encre sur
VOS étiquettes.

14
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Type Format Taille Code
Ticket Rouleau de papier continu 80 mm x 50 m C335045389 .
Premium mat
Rouleau de papier continu 102 mm x 50 m C335045390 ]
Etiquette Rouleau d‘étiquettes continu 51 mm x 35 m C33S045417 o
Premium Mate
Rouleau d‘étiquettes continu 76 mm x 35 m C33S045418 o
Rouleau d‘étiquettes continu 102 mm x 35 m C33S045419 °
Rouleau d‘étiquettes pré-découpées 102 mm x 51 mm (500 étiquettes) C33S045531 °
Rouleau d‘étiquettes pré-découpées 102 mm x 76 mm (440 étiquettes) C33S045532 o
Rouleau d‘étiquettes pré-découpées 102 mm x 152 mm (225 étiquettes) C33S045533 o
Rouleau d‘étiquettes pré-découpées 76 mm x 51 mm (650 étiquettes) C33S045534 °
Rouleau d‘étiquettes pré-découpées 76 mm x 127 mm (265 étiquettes) C33S045535 o
Rouleau d‘étiquettes continu 51 mm x 33 m C33S045536 o
Rouleau d‘étiquettes continu 76 mm x 33 m C33S045537 °
Rouleau d‘étiquettes continu 102 mm x 33 m C33S045538 °
Rouleau d‘étiquettes pré-découpées 102 mm x 51 mm (610 étiquettes) C33S045539 °
Rouleau d‘étiquettes pré-découpées 102 mm x 76 mm (415 étiquettes) C33S045540 o
Rouleau d‘étiquettes pré-découpées 102 mm x 152 mm (210 étiquettes) C335045541 o
Rouleau d‘étiquettes pré-découpées 76 mm x 51 mm (610 étiquettes) C33S045542 °
Rouleau d‘étiquettes pré-découpées 76 mm x 127 mm (250 étiquettes) C33S045543 o
Etiquette PE Mate Rouleau d‘étiquettes continu 51 mm x 29 m C33S045544 °
Rouleau d‘étiquettes continu 76 mm x 29 m C33S045545 °
Rouleau d‘étiquettes continu 102 mm x 29 m C33S045546 °
Rouleau d‘étiquettes pré-découpées 102 mm x 51 mm (535 étiquettes) C33S045547 .
Rouleau d‘étiquettes pré-découpées 102 mm x 76 mm (365 étiquettes) C33S045548 °
Rouleau d‘étiquettes pré-découpées 102 mm x 152 mm (185 étiquettes) C33S045549 o
Rouleau d‘étiquettes pré-découpées 76 mm x 51 mm (535 étiquettes) C33S045550 °
Rouleau d‘étiquettes pré-découpées 76 mm x 127 mm (220 étiquettes) C33S045551 °

* Compatible avec I'imprimante

Pour la liste compléte des supports disponibles, consultez le site :  www.epson.fr/colorworks/media

15




Utilisez le type de support jet d’encre
approprié

Ne pensez pas que toute étiquette
couchée jet dencre peut étre
appropriée pour tout type d'application

En matiere de support jet d’encre, il convient de tenir compte de 2 points :
- revétement (mat, brillant), qui est responsable de la qualité d'impression ; et

- matériel de base (papier ou synthétique/film), qui est responsable de la durabilité
de I'étiquette

Les étiquettes synthétigues ont une meilleure longévité que les étiquettes papier
et sont recommandées pour une utilisation avec les applications ou les liquides
entrent en contact avec I'étiquette.

Vous découvrirez de nombreux supports Epson d’origine sur le site suivant :
WWW.epson. fr/colorworks

Attendez-vous a imprimer des étiquettes
couleur de gualité supérieure

Ne vous attendez pas a une
correspondance de couleurs Pantone

Lesimprimantes 4 couleurs offrentune bonne qualité d'impression, mais ne peuvent
pas proposer une gamme de couleurs étendue. La correspondance parfaite
des couleurs n'est possible gu'avec les presses industrielles numérigues ou
analogiques (utilisées par les transformateurs d'étiquettes).

16
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Ajoutez a vos étiquettes des images et
du texte en couleur

N'inondez pas les étiquettes
couchées d'encre

La ColorWorks C3500 peut créer des « bandes » en raison d'espacements/
chevauchements de la téte d'impression lors de I'impression de grands blocs
de couleurs. La réduction du phénomene de bande est possible via I'utilitaire
de parametres de I'imprimante. Cela dit, le phénomene ne peut pas étre totalement
masqué/évite.

Utilisez un logiciel professionnel de
création d'étiquettes pour imprimer
les codes a barres.

Ne codez pas dans le dur les codes a
barres dans le fichier d'origine du modele
d'étiquette (jpg, pdf, etc.)

Un logiciel de création d'étiquettes (tel que Nicelabel) génerera le code a
barres exactement a la taille, la résolution et la qualité nécessaires pour étre
parfaiterent scanné.

Si, en outre, les codes a barres sont codés en dur dans I'image, et si l'image est
étirée, ceux-ci seront redimensionnés, sans conserver le rapport requis (largeur/
longueur des barres), ce qui peut entrainer des difficultés a scanner ces codes
a barres.

18
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Laissez 1,5 mm de marge sur I'étiquette

N'imprimez pas les étiquettes bord
a bord (sans marges)

La ColorWorks C3500 vous permet d'étendre la zone d'impression. Cela dit,
Iy a un risque de transfert d’encre du film protecteur vers I'étiquette ou vos doigts
(lors du décollement de I'étiquette).

Utilisez des fichiers images non
compresses, haute résolution

N'imprimez pas d'images de faible
résolution

La ColorWorks C3500 dispose d'une résolution native de 360 dpi. Cette
iImprimante sera en mesure d'offrir les meilleurs résultats d'impression avec des
iImages ayant des multiples de cette résolution : 360 dpi, 720 dpi ou 1440 dpi.
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Modifiez le mode de détection du support
avant d'insérer un nouveau Support

Ne gardez pas le méme mode de détection
du support lorsgue vous basculez d'un papier
rouleau a l'autre, car un message d'erreur
apparditra a I'écran.

Sivous passez d'un mode de détection avec margues noires a une detection
des espaces, veuillez modifier les parametres de l'imprimante via le pilote ou
'utilitaire en gardant le support initial (2 marques noires) dans l'imprimante.

Ce n'est gu'apres avoir appliqué la nouvelle méthode de détection, que vous
pouvez changer et insérer le support avec espaces.

Veérifiez la détection de la position
du support.

Ne considérez pas que la détection du
support est configurée automatiquement.

Un message d'erreur de format de support apparditra sile parametre de détection
de la position du support n'est pas correctement configure.

Par exemple, 'imprimante est définie pour détecter les marques noires, mais un
papier rouleau sans margue noire est chargé. En cas d’'erreur de type « MEDIA
FORM ERROR » (ERREUR DE FORMAT DE SUPPORT), désactivez 'imprimante.
Supprimez toute tache d'impression en attente dans le gestionnaire Activez
a nouveau l'imprimante. Accédez aux Options du pilote ou aux parametres
Utilitaires pour modifier les parametres de détection. Appuyez sur le bouton
Feed (Alimenter) pour confirmer que le message d’erreur de type « MEDIA FORM
ERROR » a disparu.
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Veuillez consulter votre représentant Epson local pour de plus amples informations ou consulter le site www.epson.fr

Epson France S.A. Support technique

Siege social, agence Paris et consommables

BP 320 - 92305 Levallois-Perret CEDEX Produits pour « Particuliers » (imprimantes et multifonctions jet
Agences régionales : Bordeaux, Lille, Lyon, d’encre, scanners Perfection)

Marseille, Nantes, Strasbourg, Toulouse. - Produits sous garantie : 09 74 75 04 04

Information : 09 74 75 04 04 (Tarif d’'une communication locale hors codits liés a I'opérateur)
(Tarif d’'une communication locale hors codts liés a I'opérateur) - Produits hors garantie : 0 899 700 817

Pour plus d’informations, visitez www.epson.fr (1,34 EUR/appel et 0,34 EUR/min)

Produits pour « Professionnels » (Laser, Jet d’encre PRO,

Matricielles & impact, Scanner, VidéoProjecteurs, Etiqueteuses,
Imprimantes Points de vente, Billetterie, Etiquettes,
Scanner de chéques, Duplicateurs)

- Produits sous garantie et hors garantie : ®
0821017 017 (0,12 EUR/min) E PSON
Les marques commerciales et marques déposées sont la propriété de Seiko Epson Corporation ou de leurs détenteurs respectifs.
Les informations sur les produits sont sujettes & modification sans préavis. EXCEED YOUR VISION



